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1. INTRODUCTION

WHAT IS MOODLE?

Moodle is a learning management system (LMS) — a software package designed to help

users / educators create quality online courses and manage learner outcomes. Moodle is
Open Source software, meaning users are free to download it, use it, modify it and even

distribute it.

BEFORE WE START — FOR ADMINISTRATORS

Moodle can be downloaded from Moodle’s download page: https://download.moodle.org/.
This user guide will not touch on the requirements to run the Moodle page on the chosen
server. Please consult the IT Department in the Office on this matter.

@A DOCUMENTATION [DOWNLOADS! DEMO TRACKER DEVELOPMENT TRANSLATION MOODLENET Q

fhoodledownloads

Freedom to learn.

Moodle is open source under the GPL
licence. Everything we produce is available
for you to download and use for free.

Cherk niit our latest release:;

MOODLE 3.4+

Standard Moodle Extend Moodle

Install Moodle on your own server (requires a web server with Browse our extensive Moodle
PHP and a database). plugins directory for extra activities, %
blocks, themes and more.
Latest release

Obtaining Moodle via Git

Development release

Further guides on installation can also be found here:
https://docs.moodle.org/34/en/Main_page
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erview & » Moodle Docs 3.4

Main page

\dmin quick guide

Installation quick guide

re about Moodle Mobile ==

3|Page



2. SETTING UP THE FRONT / HOME PAGE

During installation, a few things will need to be set up first:

Front page settings

Brief explanation of a few items shown:

)] Full site name: the title of the site; appears at the top of every page above the
navigation bar

ii) Short name for site: appears at the beginning of the navigation bar as a link back
to the front page

iii) Front page summary: can be displayed on the front page using the course/site

summary block; it is also used as the HTML metadata description in some themes

By default, a new Moodle site comes with ‘Boost’ theme and two other standard themes,
‘Clean’ and ‘More’. After installation, the new site (depending on the Moodle version
installed) may look like this:
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A ® Admin User

Show/Hide
Navigation Drawer

Settings

Patent Examination Trammng =% -

Site home & Turn editing on

<— Navigation Drawer
Calendar £3 Edit settings

Available courses

Private files Y Filters

Add a new course
[ Backup

Site administration
1 Restore

£+ More..

A few things for making navigation of Moodle easier:

i) Navigation Drawer: Listed major navigation categories for ease of access. It can
also be customized. The button above is used to show/hide the navigation drawer
i) Settings: The gear menu is used to turn editing on/off

If Boost theme is used, by default the administration block is not on the front page. To add
the administration block, simply click ‘Add a block’ button (make sure that editing is turned
on):

Add a block

Click ‘Administration’

Click ‘Add a block’

A
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Patent Examination Training

Administration block
is now added to the  unisTRATION 4. -
front page

¥ Y Front page setting

Each of these boxes is called
“block”

If editing is turned on, the added block(s) can be dragged and moved.
There are multiple ways for an administrator to edit the settings of the front page. One of the
ways would be to click ‘Edit settings’ from the Administration block from the front page. Or if

the ‘Boost’ theme is used, click the gear menu top right of the front page and then click ‘Edit
settings’.

FRONT PAGE SETTINGS

This is where administrator (or other users with permission to edit these settings) can
customize the site. Brief explanation on the items in this page:
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Front page settings

i)
ii)

iv)

Full site name: the title of the site; appears at the top of every page above the
navigation bar

Short name for site: appears at the beginning of the navigation bar as a link back
to the front page

Front page summary: can be displayed on the front page using the course/site
summary block; it is also used as the HTML metadata description in some themes
Front page: items that will be displayed on main page before logged in

Front page when logged in: items that will be displayed on the main page when a
user is logged in.

APPEARANCE SETTINGS

Apart from configuring the items to be displayed, administrators (and of course, users with
permitted access) can also customize the appearance of the site (for example, adding
images / logos, changing color to suit corporate color of the organization, etc.). Appearance
settings can be accessed from ‘Appearance’ tab in the ‘Site administration’ block.

Moodle also has hundreds of user-created themes that can be chosen from, where different
themes may display blocks in different parts of the page. Even when a theme is selected, an
administrator can still customize the appearance of the page. For example, the screenshot
below is from a theme where all blocks are arranged on the left side of the page:
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3. USER PROFILE SETTINGS

In order to fully utilize Moodle as a tool for managing training of patent examiners, certain
criteria have to be added to the existing user profile fields. For example, certain trainings
require the participants to have been an examiner for a certain number of years, have
technical degree in a certain field, expert in conducting examination for application in certain
International Patent Classification (IPC) class, and so on. Luckily, Moodle has the option of
adding or even modifying user profile field, so administrators / managers can easily browse
through or filter the list of users based on these fields.

HIDING UNUSED DEFAULT USER PROFILE FIELDS

When creating a new user, the user can fill out the details in his/her profile. For example,
Moodle has dedicated fields for personal Web page, ICQ number, Skype ID and other
personal details to be displayed in the user profile page. Even though this details will not be
shown if there is nothing inserted, it would be advantageous to hide these personal details
altogether from the profile page to make room for custom user profile fields.
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P —)
- User picture

Additional names

Interests

- Optional

Web page

ICQ number

Skype ID

AIM ID

Yahoo ID

These profile fields can be hidden by going to Site administration > Appearance > Themes,
then choose the theme that is currently being used. For example, is the theme used in the
‘Clean’ theme, choose Clean. In the ‘Custom CSS’ box, type these commands:

fieldset#id_moodle_optional {display: none;}
fieldset#id_moodle_additional_names {display: none;}
fieldset#id_moodle_interests {display: none;}
fieldset#id_moodle_picture {display: none;}

Then click ‘Save changes’ to proceed.
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Appearance
w Themes
£F Theme
settings
£F Theme
selector
£+ Boost
£+ Clean
£¥ More
Logos
Calendar Display site name along with

Blog small logo

Navigation a_ck kename
$ HTML settings

Moodle Docs

Default
Dashboard
page

% Default profile
page
Courses

% AJAX and

Custom CSS

You can drag and drop files here to add them

The small logo is displayed in the navigation bar. If there is a header logo
for the front page and login page, the small logo is not displayed on these
pages. If a logo is not added here, the compact logo in Appearance >

Logos will be used.

¥ Default: Yes

If there is no small logo, the site name is always displayed in the
navigation bar. If a small logo is set, it may be displayed with or without
the si

fieldset#id_moodle_optional {display: none:}
fieldset#id_moodle_additional_names {display: none;}
fieldset#id_moodie_interests {display: none;}
fieldset#id_moodle_picture {display: none;}

These profile fields now are no longer shown in the ‘edit profile’ section.
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Description

Custom fields are now directly
below general fields

Other detalls

Institution

Academic Education

Patent Examination details

CREATING NEW USER PROFILE CATEGORY
Go to Site administration > Users > Account > User profile fields

By default a category called ‘Other details’ are already created. New user profile fields can

be created as part of the ‘Other details’ category. If an administrator wishes to create a new
profile category, click ‘Create a new profile category’:
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Blocks editing off

User profile fields

Other details =

Create a new profile field:  Choose \R | Create a new profile category

Give a new name for the category, then proceed by clicking ‘Save changes’:

Creating a new category

Category name (must be unique) *

Patent Examination details| Give a name for the new

category

There are required fields in this form marked *

Now there are two categories that can be customized:

User profile fields
Other details =

MNo fields have been defined

Patent Examination details »

Create a new profile field. Choose v OR | Create a new profile category
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CREATING NEW USER PROFILE FIELD

Now, to create a new user profile field, choose one of the available options when clicking the
drop-down arrow:

User profile fields

Other details =

No fields have been defined

Patent Examination details =

No fields have been defined

Create a new profile field: | Choose v | OR | Create a new profile category
Checkbox
Date/Time
Dropdown menu
Text area
Text input

For example, if there is a need to create the recruitment date of appointment of the user as a
patent examiner, choose ‘Date/Time’ option from the menu. If the profile field only concerns
month and/or year, it would be better to choose dropdown menu for each month and/or year
option, as shown below:
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Academic Education

Highest Academic Degree *

Master

Month Attained *

September v

S~

Different dropdown option for
month and year

Year Attained /

2010 v

Technical Qualification *

BSc. in Electrical Engineering (majoring

In the next page, fill you the required columns for the new profile field. It is recommended to

put only one word in the ‘Short name’ column for easy reference.
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Creating a new 'Date/Time' profile field

~ Common settings

Short name (must be unique) *

Start date as a Patent Examiner

Description of the field

Appointment date as a patent examiner in the Patent Office|

Specify other settings for this field. A short explanation on these items:

Vi.

Vii.

Is this field required? : a user must fill this field

Is this field locked? : It this field is locked, once inputted, only users with
authorization are allowed to change it

Should the date be unique? : Uniqgue means only one user can key in the same
input. For example, recruitment date may not be unique, but staff ID number may
be unique

Display on signup page? : The custom field is displayed during signup. Choose no
if the user field can only be inputted by authorized users, not users themselves
Who is this field visible to? : Choose visibility settings

Category: If there is new category created, choose between the default category
(‘Other details’) and the new category. If there is no new category created, the
custom field will be put under the default category.

Other specific settings depending on the type of user field created

After completing the suitable preferences, click ‘Save changes’ to proceed.
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Is this field required?

Yes

Is this field locked?

Yes ~

Should the data be unique?

No v

Display on signup page?

Yes v

Who is this field visible to? (&)

Visible to everyone v

Category

Patent Examination details v

Specific settings

Start year

1900 v

End year

2018 v

Include time?

Save changes Cancel

For a user profile field in which a user has to choose on of possible options, choose the
‘dropdown menu’ option, and under the specific settings, every option is in one line, as
shown here:
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» Specific settings

Menu options (one perline)

A01B

Default value

However, this type of option only allows one item to be chosen. It may be a good idea to use
Text Input for multiple inputs.

When a user first signs up, these customized fields will be displayed:
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Month Attained *

September v

Year Attained *

2010

Technical Qualification *

BSc. in Electrical Engineering (majoring

Institute / University *

Universiti Kebangsaan Malaysia

» Patent Examination details

Recruitment as a Patent Examiner *

16 v | January v 2006 ~ 1

Technical Fields *

HO2J

Update profile

After that, depending on the preference settings, all the customized fields will be shown in
the user’s profile page:
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User details

Edit profile

Email address
Sofiarehan.Ramli@wipo.int

Year of Birth
1982

These are all customized user
profile fields

Intellectual Property Office of
Malaysia

Highest Academic Degree
Master

Month Attained
September

Year Attained
2010

Technical Qualification

BSc. in Electrical Engineering
(majoring in Power)

Institute / University
Universiti Kebangsaan Malaysia

Recruitment as a Patent Examiner
16 January 2006

Technical Fields
HO2J

ADDING USERS

https://docs.moodle.org/33/en/Add users

EXTRACTING DATA OF USERS
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Administrators (and users with permissions) have the ability to view and download user data.
To view the list of registered users in the Moodle site, go to Site administration > Users >
Accounts > Browse list of users:

Blocks editing on

3 Users

+ New filter

b Site pages

b Courses

User full name

To filter user by name

contains

Add filter

Show more
Firstname / Summame Email address Cityitown Country Last access Edit
Admin User Sofiarehan.Ramii@wipo.int now
i+ Browse list of Examiner AAA examiner.aaa@yada.com Geneva  Switzerland Never
users =
examiner bbb@yada.com Never

Add a new user

However, as the name suggests, this only allows the administrator to view the list of users. It
also only allows the results to be filtered by user full name.

In order to extract full data of all users, or a group of users with certain criteria, go to Site
administration > Users > Accounts > Bulk user actions.

This page also has the header ‘New filter’, similar to Browse list of option page. However,

instead of having only one filter, clicking ‘Show more..." will reveal that the list of users can
be filtered using any field found in the user profile:
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Site administration Jsers Accounts u actior Blocks editing on

~ New filter

User full name

1ins

Add filter Click here to see the list of
< | available filters

=now more

~ Users in list

- | Selected | No users sel

% Bulk user
actions

L Add a new user

Add to selection Remove from selection

Add all Remove all

Filters according to the custom user profile fields are also possible. Notice that the user
profile field is based on the short name of the field:

b Server €T profile fields
Reports o I
any field coniains
Mobile app
Development
£ Assignment upgrade Startdate

helper Technicalqualification
any Toe M

System role *

Search

any role

Cohort ID *

is equal to

For example, if the administrator wants a list of users that examine applications relating to
human necessities (A section), then click ‘Add filter”:
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Security
Appearance
Front page

Server

Reports Course role *
Mobile app

any role v | any category
Development

£ Assignment
upgrade helper System role *

any role

Cohort ID *

is equal to

Now the ‘users in list’ will only show users in which his/her IPC starts with A:
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User profile fields: IPC starts with a This section will display all active
filters

Remove selected Remove all filters

- Users in list

Users (O List of users that fulfill the
conditions of the filter

Available | Ajl filtered (1
Examiner AAA

Add to selection Remove from selection

Add all Remove all

With selected users...

Choose

To download the list of users, choose ‘Download’, then click ‘Go’:
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Add to selection Remove from selection

Add all Remove all

With selected users...

Choose v Go %2/
=

Confirm
Send a message

e

ay on page
r ‘ = L1
Download

Force password change
Add to cohort

Choose the format of the file containing the list of users, then click ‘download’:
Dashboard Site administration Users Accounts Bulk user actions Blocks editing on

Download

Dashboard

Export users as | Comma separated values (.csv) v Download

b Site pages Comma separated values (.csv)

b Courses

Once the file has been downloaded, click the file to open it. This is how the document looks
like if it is in Microsoft Excel (.xIsx) format:

The custom user profile fields are usually to the right of the default fields, as shown above.

Regarding dates, in the spreadsheet, the dates are using a Unix timestamp format, wherein
the system describes the point as the number of seconds that have elapsed since
Coordinated Universal time (UTC), 1 January 1970. To convert the format back to date, in a
new column, use this formula:

=(A1/86400)+25569+(-5/24)+1

Where Al is the cell containing the Unix timestamp. Then, right click on the cell to change its
format to Date. The additional column now displays the recruitment date in date format, as
shown below:
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E | s ' v
lastname profile_field_Startdate/ Startdate ofile_field_IPC profile_field_Technicalqualification
AAA "1483311600 02.01.2017 AQ1L PhD. in Analytical Chemistry

User "1137366000 16.01.2006 HG2) BSc. in Electrical Engineering (majoring in Power)
BBB "1485039600 22.01.2017 BO1DS7 M.S in Biotechnology
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4. ROLES IN MOODLE

Normally in a classroom training program, a hierarchy of examiners with differing capability is
needed to maintain the flow of the training. Not all examiners who are involved in a training
program have the same roles. For example, when there are trainees, there must be trainers,
coordinators, and so on. Similar approach is also applicable in Moodle. Moodle has several
default roles that can be customized according to the needs of a patent office.

For example, the usual roles found in training are as follows:

ROLE DESCRIPTION

Coordinator the person in charge of the training, usually does not
involve in the training, but rather managing the training

Supervising Examiner / Mentor may or may not directly involved in the training, mainly
for assisting trainees

Trainer examiners who are responsible for training the trainees,
also the grader

Examiner examiners who are not involved in the training

Trainee examiners who are involved in the training

In Moodle, the standard roles and their description are:

ROLE DESCRIPTION

Manager Can access and modify course, usually do not
participate in courses

Course creator Can create new courses

Teacher Can do anything within a course, including changing the
activities and grading students

Non-editing teacher Can teach in courses and grade students, but may not
alter activities

Student Generally have fewer privileges within a course

Guest Have minimal privileges and usually cannot enter text
anywhere

Authenticated user All logged in users

Authenticated user on frontpage | All logged in users in the frontpage course

As can be seen, some of the roles in training have the same function as the role created in
Moodle. Moodle also allows changing the role name, therefore it would be advisable to follow
the role in training.

To change name of standard roles in Moodle, go to Site administration > Users > Permission
> Define roles. Click the name of the role that is to be changed. In this example, ‘Manager’
will be changed to ‘Coordinator’.

In the next page, click ‘Edit’ to edit the name.
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Dashboard » Site administration Users » Permissions Define roles Blocks editing on

Manage roles  Allow role assignments  Allow role overrides  Allow role switches

Dashboard

S ) Viewing the definition of role 'Manager' ®

b Site pages
« My courses

» PrevCourses m
. Training Needs Self-
assessment
KPI
Export
b Assessment

+ Site administration Short name
£% Notifications manager
Registration
% Advanced features Custom full name
v Users Manager
p Accounts
v Permissions Custom description
2% User policies Managers can access course and modify them, they usually do not participate in courses.
1+ Site
administrators ~ Role archetype

L3 Define roles ARCHETYPE: Manager

The ‘Custom full name’ box is left empty. By default, the ‘Custom full name’ box of all roles is
empty, so the role will follow the name written in the ‘Short name’ box. So, in order to change
the name of the role, key in the desired name in the ‘Custom full name’ box. Then click ‘Save
changes’ to proceed.

Please do not change the short name of any of the standard roles.

VIGATION =l Manage roles Allow role assignments Allow role overrides Allow role switches

NAVIL

Dashboard

2:9“"”"-‘ Editing role ‘'Manager' @
p Site pages - ‘ )
= My coxkoes e — ance| Click ‘Save changes’ to proceed

» PrevCourses

. Training Needs Self- 2
" assessment Short name Z

» KPI manager
b Optics
P Assessment Custom full name

Coordinatol  <—{ |nsert new custom name here

Custom description
o

ADMINIS ION
w+ Site administration
4 Notifications
£ Registration
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The role now has been changed to ‘Coordinator’.

Manage roles Allow role assignments Allow role overrides Allow role switches

Role () Description Short name

Coordinator Managers can access course and modify them, they manager
usually do not participate in courses.

Course creator Course creators can create new courses, coursecreator
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5. COMPETENCY FRAMEWORKS

Competencies describe the level of understanding of proficiency of a learner in certain
subject-related skills. In Moodle, it is possible for an administrator / manager to create and
apply competency frameworks for evaluating patent examiners against competencies. The
competency framework for patent examiners can be downloaded here: <URL>

FOR ADMINISTRATORS: SETTING UP COMPETENCY FRAMEWORK

Site Administrators can create a competency framework and define associated
competencies. Below are the steps in setting up competency framework:

)] Enable Competencies
Administrators can double check that competencies are enabled on the Moodle
instance. To enable competencies:
Site administration > Competencies > Competency settings

Patent Examination Training

Category: Administration / Competencies DOMIN e ol -

ii) Import Competency Framework
To import competency framework, go to: Site administration > Competencies >
Import competency framework
Click ‘Choose a file’, and choose the competency framework for patent examiners
downloaded earlier. Alternatively the file can be dragged and dropped to the box
with big blue arrow to be added (however this option is currently not available if
Internet Explorer browser is used).
Click ‘Import’.
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Import competency framework

Import competency framework DO g | e
h o Choose a flle

Click ‘Confirm’.

Import competency framework

Processing file ADMIN BOOKMARKS

Confirm the column mappings

1D et

Click ‘Continue’ to proceed.
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Import competency framework

Processing file

Importing file data

Once competency framework has been added, administrators can use the
competency to create learning plans. The template competency framework can
also be modified.

Competencies

Training for Patent Examiners .

Competencies

Click ‘Add competency’ if want to
add sub-item in the competency
framework

FOR MANAGERS / TEACHERS: CREATE LEARNING PLAN TEMPLATES

Once competency framework has been set up, the next step is creating a learning plan
template. A learning plan template is handy when there are many patent examiners in one
Office and each examiner’s progress in terms of competencies needs to be monitored and
tracked. A template also means that it is easy to implement changes to the learning plan, as
a change in the template will change the individual learning plan of the examiners.

i) Create learning plan templates
Go to Site administration > Competencies > Learning plan templates
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Patent Examination Training

ADMINISTRATION
our sde s not yet registered

Site administration

Click ‘Learning plan templates’

All learning plan templates that have been created will be displayed here. To add
a new learning plan template, click ‘Add new learning plan template’:

Patent Examination Training

Learning plan templates ADMIN BOOKMARK S

st e eamng s e <—— | Click here to add new template

List of learning plan templates

Name Cohorts Learning plans

Create a new learning template by giving it a name, and optionally a short
description of the template:
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Patent Examination Training

Learning plan templates ADMIN BOOKMARKS

Add new learning plan template
General

Name

Desariotion

Click here to save the new
There are required fizlds in this form marked @ template

i) Adding competencies to a learning plan template

Once a learning plan template has been created, managers/teachers can add

competencies that must be achieved for all patent examiners under the learning
plan template:

Patent Examination Training

ADMIN BOOKMARKS

Leaming plan lemplate created

Training for Patent Examiners Level 1 &

For newly-ecruited patent examiners

/ Click here to add competencies
Add competencies to kaming plan templale

Learning plan template competencies

o competencies have been inked to this leaming plan template.
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Competency picker

Competency frameworks
Training for Patent Examiners T1.0

Locate competency

Search Q

R Choose the relevant
> woperty and Paten «| competencies to add to the

O learning plan template

b Assess Novelty
b Assess Inventive Step
Technology-Specific Examination

Examinations within a National Context
Supplementary
After selecting all competencies,

click ‘Add’
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ii)

Leaming plan template created
Training for Patent Examiners Level 1 ¢
For newly-recruited patent examiners

Add competencies to leaming plan template

Learning plan template competencies

0 out of 4 competencies linked o courses

All competencies related to the
+ Nature and function of IP nghts 1.1 |earning p|an template will be
aning for Pawnt Eamingrs - Compansy ||Sted here

Path: 1
Linked courses: [

<+ Function of international and national IP offices 1.2

Traning B¢ Pannt Examing

Path: 7
Linked courses:

+ Laws, treaties and conventions governing international and national patent systems 1.3

aning BrRawnt Sominers - Compewnc

Path
Linked courses:

+ Function and processes of patent examination and the role of patent examiners 1.4

aning B PawnExn

Path: 7
Linked courses:

Creating cohorts

Cohorts are site-wide groups. The purpose of cohorts is to enable all members of
the cohort to be easily enrolled in a course, or assigned with a learning plan with
only a few clicks.

To create a cohort, go to Site administration > Users > Account > Cohorts

The page will show all available cohorts. Click ‘Add new cohort’ to create one:
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Patent Examination Training

Click ‘Add new cohort’
System: available cohorts /

Systam cohorts

Search cohort Search

Name Description Source

Add new cohort

Give a title for the
newly-created cohort
and optionally a short
description about the
cohort

Click ‘Save changes
to save the cohort

Search cohort earch

The new cohort will be listed on

Name Source Edit

available cohorts
Patent Examiners Level 1 & rd Lq Crealed manually » 0 o8

iv) Assigning users to a cohort
To assign a user to a cohort, click the rightmost icon under the ‘Edit’ column:

37|Page



System: available cohorts (1)

System cohoris

Search cohort Search

Name CohortID  Description Cohort size  Source Edit

Patent Examiners Level 1 4 ra Level 1; Patent examiners with 0 - 2 years of experience 0 Created manually - 0O

I Click this icon

Click the users to be added to the cohort. Hold ‘Ctrl’ to choose more than one
user. Then click ‘Add’.

Cohort 'Patent Examiners Level 1' members

Current users Potential users

None Potential users (3)
Examiner AAA (examiner.

Choose the user(s) to be added
to the cohort, then click ‘Add’

Search Search

Search options

Back to cohorts

The users are now added to the cohort.
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v)

Cohort 'Patent Examiners Level 1' members

Current users Potential users

Current users (2)

Potential users (1)
XaT examine Admin User (Sofiar

Search
Search options »

Back to cohorts

Similar steps can also be done to remove users from a cohort.

A user can be added to more than one cohort.

Assigning a learning plan template to an individual or a cohort
To assign a learning plan to an individual or a cohort, go to:
Site administration > Competencies > Learning plan templates

Learning plan templates

Add new leaming plan template
List of learning plan templates

Name Learning plans Actions

con

Edit

€4 Duphcate

< Creale leaming plans

< Add cohorts to sync

Delete

To assign the learning plan to an individual, click ‘Edit’ then click ‘Create learning
plan’
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Training for Patent Examiners Level 1
Learning plans

Select users to create leaming plans No selection

for | Choose the users (trainees) to
assign the learning plan to

Nothing to display

Similarly, to assign the learning plan to a cohort, click ‘Edit’ then click ‘Add cohorts
to sync’

Training for Patent Examiners Level 1
Cohorts synced to this learning plan template

Select cohorts to sync No selection

| Choose the related cohort to be
/ synced to the learning plan

Patent Examiners Level 1 (¢

Nothing to display

After all has been completed, on the page of learning plan templates, viewers can
see the number of cohorts and/or individuals assigned to the learning plan:

40|Page



Patent Examination Training

Learning plan templates

Add new leaming plan template
List of learning plan templates

Name Cohorts Learning plans

NN

Alternatively, adding a cohort or an individual can be done by clicking the number
corresponding to cohorts or learning plans. For example, if an individual needs to
be added to the learning plan template:

Learning plan templates

Add new learning plan template

Click the number to
add more individual

List of learning plan templates

Name Category Cohorts Lfning plans Actions

Training for Patent Examiners Level 1 System ) 0 Edit -

Training for Patent Examiners Level 1

Learning plans Click the downward arrow where

it will list all available users.

Select users to create learning plans for

No selection

v

fimin User Sorarehan Rami@upoins—— | Click the users to be added to
: the learning plan

Nothing to display
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Training for Patent Examiners Level 1

Learning plans

Select users to create learning plans for

v

<«—— | Click ‘Create learning plans’

Create learning plans

Learning plan templates Training for Patent Examiners Level 1

Notification on a learning plan for
the user has been created

Training for Patent Examiners Level 1

Learning plans

Select users to create learning plans for

Mo selection

Creale learning plans

This user now has a learning
plan

Name First name /

Training for Patent Examiners Level 1 Admin User

Similar step is also applicable for creating learning plan for cohorts.

A user can be assigned to more than one learning plan template, even when the
learning plan templates have overlapping competencies. This is advantageous
such as when there are different templates available for different work experience,
technical background or different competency framework altogether.
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Examiner BBB

™ Message 4 Add to your contacts

Dashboard Users Examiner BEB Learning plans

Learning plans

This user has two different
Add new learning plan learning plans assigned

List of learning plans

Name Template based Status Actions

Supplementary Learning Plan Template Active Edit ~

Training for Patent Examiners Level 1 Active Edit ~

FOR USERS / TRAINEES / EXAMINERS: VIEWING OWN LEARNING PLAN

A user can view his/her learning plan from the profile page. One way to view the profile page
is by clicking the down arrow next to profile picture on the top right of the page, then click
‘Profile’.

Training Management

%® Dashboard

Individualized and Competency based Patent Ex
Training Management i Grades

Messages

WELCOME Mission \ £+ Preferences

The World Intellectual Property Organization promotes inno [ Log out

This is a test site for 4 /and creativity for the economic, sogial and cultural develop
implementing the 1 all countries, through a balanced and effective international FEEETGIRGIEE

individualized and \lintellectual property system.
competency based patent

examiner lralnmg
management

Available courses

Learning plans can be viewed by clicking ‘Learning plans’ under the ‘Miscellaneous’ tab.
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Admin User

Reset page to default Customise this page

User details Reports

Email address

Sofiarehan.Ram

Start date as a Patent Examiner
16 January 2006

Relevant IPC classes
b Site administration Ho2J

Technical Qualification Login activity
Search BSc. in Electrical Engineering (majoring in

First access to site
Power)

Tuesday, 9 January 2018, 1:51 PM (16 days
1 hour)

Miscellaneous Last access to site

Biog entries Thursday, 25 January 2018, 3:34 PM (1 sec)
DI0g entnes

Notes Last IP address

0:0:0:0:0:0:0:1

Admin User

Learning plans

Add new learning plan

List of learning plans
Name Template based Status Actions

Training for Patent Examiners Level 1 [ Yes | Active Edit =
b Site administration

Learning plan assigned to user

Search

Alternatively, learning plan is also listed on the dashboard of a user (usually after the login
page).
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Admin User

Dashboard Customise this page

Dashboard No files available

Manage private file

Courses

Site administration

You have no badges to
display

Search

Learning plans Training for Patent Examiners Leve

Training for Patent Examiners Level 1

Dashboard
= Site home For newly-recruited patent examiners

b Site pages —
u

COUFSeS Active (Cr > this learning plan)
Learning plan template
Training for Patent Examiners Level 1 (Unlink from learning plan temg
Progress

0 out of 4 competencies are 0.0%]

Site administration
= proficient

¥ Commenis () List of competencies under the

Search
. | assigned learning plan
Learning plan competenci 9 9p

Name Rating Proficient Status Actions

Mature and fun No - Edit

Path: Training

Function of in

Path: Training for

Laws, treaties and conve
national patent

Path: Training

Function and
patent examir

Path: Trainin
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6. CREATING A COURSE

After setting up users and their learning plan, the next step is to manage their training and
competency. Although the primary objective of this LMS is to monitor and measure these
examiners’ performance and not developing own online courses, performance measurement
is conducted through reports and analysis. In Moodle, these reports and analysis can be
obtained by means of a course. Although it is called a course, technically for patent office’s
purposes, the course is a way to monitor the examiner’s performances as all activities and
resources can easily be developed in a course.

More information about creating courses can be found here:
https://docs.moodle.org/33/en/Courses.

SELF-ASSESSMENT

Coordinators can develop a customized self-assessment questionnaire by utilizing the
various activities available for a course. The self-assessment questionnaire can also be
analyzed and extracted for future reference. After creating a course, an administrator (or any
users with similar permissions) can add activities in the course by clicking ‘Add an activity or
resource’. Please make sure that editing is turned on in order to make is possible to add
activities or resources.

My courses Training Needs Self-assessment Turn editing off

Make sure editing is turned on

Questionnaire

A self-assessment questionnaire for each participant
Dashboard

= Site home
b Site pages Announcements

bl A
v My courses ft ¥ Patent Information

p Freviourses

% {4 search Methodologies

Self-assessment st { Patent Classification

_ Training Needs

& { Substantive Examination Tasks

uestionnaire

l_-J_';;'f:-:_':'-

p Assessment

A popup will appear, listing all possible activities and resources that can be included in the
course.

A brief explanation for each type of activity can be found here:
https://docs.moodle.org/33/en/Activities. A brief explanation for each type of resource can be
found here: https://docs.moodle.org/33/en/Resources.
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Normally, the type of activity is determined from the intended outcome. If there is an
expected correct answer, most probably a quiz type activity is preferred. If the questionnaire
is in the form of dichotomous, three-point or five-point scale, the suitable activity would be of
feedback type. If the questionnaire is directed to survey after a course/training/lesson, most
probably survey-type activity is preferred (please bear in mind that survey-type activity has its
own default fixed questions).

In this example, a feedback-type activity is preferred. Click ‘Feedback’ and then ‘Add’ to
proceed.

Add an activity or resource

ACTIVITIES

Select an activity or resource to view its help

R Jouble-click on an activity or resource name to
| Assignment Double-click on an activity o ource na C

quickly add it
) Chat
Choice
Database
Dataform
[ Extemal tool
Forum
\ag Glossary
Lesson
Quiz
| SCORM package

Survey

x Workshop

RESOURCES

I oo ,
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Give a title for the activity, and any other settings suitable. For example, the activity can be
made such that users can answer anonymously, multiple times, and so on. Click either save
button to continue.

e —
General

Name *

Patent Information

Description

Display description on course page

Availability

~ Question and submission settings

Record user names

User's name will be logged and shown with answers ¥

Allow multiple submissions (7

EXTRACTING DATA FROM THE COURSE

Depending of the type of activities chosen, a coordinator can obtain an analysis of answers
by users enrolled in the course. As an example, if a weighted scale response using feedback
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type is used, a coordinator can collect data on all responses from the ‘Analysis’ tab on the
activity. The responses can also be exported to Excel, by clicking ‘Export to Excel'.

Patent Information

Overview Edit questions Templates Analysis Show responses

Show non-respondents

Submitted answers: 3
Questions: 9

Name and explain the different parts of a patent document

B Responses

(3) 1am confident to do so

ning to improve my skills and knowledge on this matter

(1) I'have never had training on this matter

Show chart data

Average: 2.00

An example of the Excel file showing the feedback response is shown below.
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13 March 2018, 11:25 AM
Feedback: 3
Questions: 9

Label Question Responses

Name and explain the different pail am confident to | feel somehow c | have never had Average

1 1 1 2
Explain types and categories of cl:| am confident to | feel somehow c | have never had Average

2 1 0 2.666666667
Explain application, publication an| am confident to | feel somehow c | have never had Average

1 1 1 2
Explain the different types of patel | am confident to | feel somehow c | have never had Average

1 1 1 2
Determine the meaning of a given | am confident to | feel somehow c | have never had Average

2 1 0 2.666666667
Explain the concept of INID codes | am confident to | feel somehow c | have never had Average

2 1 0 2.666666667
Explain what WIPO Standards are | am confident to | feel somehow c | have never had Average

1 2 0 2.333333333
Explain what authoritative (primar | am confident to | feel somehow c | have never had Average

1 1 1 2
Explain the difference between 'pL| am confident to | feel somehow c | have never had Average

1 1 1 2

This analysis can also be accessed via the feedback administration section in the
administration block.
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3 Feedback
~ administration
Edit settings
Locally assigned
roles
Permissions
Check
permissions
Filters
Logs
Backup
Restore
Questions
s Edit questions
s Export
questions
s Import
questions
» Templates

» Analysis

» Show responses

Show non-

respondents

For a quiz type of activity, there is a quiz administration section available in the
administration block. Under the ‘Results’ tab, a coordinator can view overall grades and
statistics. The report can also be downloaded in various formats.
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v Quiz administration
Edit settings
Group overrides
User overrides

% Edit quiz

| Preview

Grades
Responses
o Statistics
o Manual grading
Locally assigned
roles
Permissions
Check
permissions
Filters
Logs
Backup
Restore

Question bank

Course
administration
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Dashboard My courses Assessment Priorities Priority Assessment Test Results Statistics

Priority Assessment Test

Dashboard
Se home No attempts have been made at this quiz, or all attempts have questions that need
Site pages manual grading
» My courses
» PrevCourses
y Training Needs - Statistics calculation settings
Seff-assessment
KPI
» Optics Calculate statistics from
[ Assessment highest graded attempt v
p Participants
¥ Badges
= Competencies
Ef Grades
b General
w Priorities
« Priority
Assessmen  Quiz information

t Test

b atent Families o T , = s e
Patent Familie Download full report as | Comma separated values (csv) v Download

p e T Relnd | Comma separated values (csv) |
Comma separated values (.csv)
p Other Mic oft Excel (.xlsx)
Quiz nam table Assessment Test
ript Object Notation (.json)

ocument (.ods) e Assessment Test
Number of complete graded first attempts 0

+ Quiz administration Total number of complete graded attempts 0

7. CREATING A QUIZ / FEEDBACK IN MOODLE

Moodle is also equipped with custom activities such as a quiz or a feedback. As mentioned
earlier, since Moodle is aimed for delivery of blended online learning, these activities must be
incorporated in a course. To learn more about creating activity in a course, please refer here:
https://docs.moodle.org/34/en/Managing_a_Moodle_course

Moodle also supports importing a quiz from a Word document, which makes incorporating
existing standalone quiz into Moodle a breeze. A demonstration on importing a quiz from a
Word document can be found here:

https://www.youtube.com/watch?v=6R1TM6IGrCQ
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8. IMPORTING A COURSE TO MOODLE

Apart from creating a course from scratch, Moodle also allows importing a course to be
uploaded to the site. For example, if WIPO or any other patent office is interested to conduct
a questionnaire or survey, the questionnaire / survey can be uploaded to the Moodle site (in

the form of a course) and it can then can be accessed by users.

ADDING A CATEGORY / CREATE NEW CATEGORY

To go to course settings, go to Site administration > Courses. By default a ‘Miscellaneous’

category is already created. To add a new category, click ‘Add a category’:

Dashboard Site administration

Category: Administration / Courses

Dashboard

= Site home

) Site pages Manage courses and categories

Add a category

Restore course

Course default settings

Visible

Course format

Format

Blocks editing on
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Add new category

If it is a main category, choose
g ‘Top'. If the new category is a
Top / subcategory, choose the existing
category

Category name *

/ Name of the new category

Prior Learning

Category ID number (2

Description

Description of the new category
(optional)

Any course related to recognition of prior learning is in here |

Create category Cancel

Click ‘Create category'.
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Course and category management

Viewing: Course categories and courses~
Course categories
Create new category

Miscellaneous

Prior Learning The new category is now listed

Sorting
Selected categories ¥
Sort by Category name ascending

Sort by Course full name ascending

Move selected categories to

Choose ¥ Move

IMPORTING / RESTORING A COURSE

In this example, a preset questionnaire will be uploaded to the site. Since the title of the
guestionnaire is ...., preferably the suitable category is ‘Prior Learning’. To upload a course,
go to Site administration > Courses > Restore course.

The easiest way is to drag the previously downloaded file to the big white box (if using any

browser other than Internet Explorer). Alternatively, click ‘Choose a file...” and choose the
file:
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Import a backup file

Files *

Choose a file.

Drag the downloaded file to here

\ 4

You can drag and drop files here to add them

There are required fields in this form marked *

Course backup area @

Filename Time Size Download

Import a backup file

Files *

Choose a file

backup-moodle2-course-6-training_needs_self-assessment-20180115-1522-nu.mbz

Click ‘Restore’
Restore
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Course details

Title Training Needs Self-assessment

OriginalID 6

Course sections

Section: Questionnaire Included in backup (no user information)

Activities e
Forum

- | Feedback

i | Feedback

€ | Feedback

- | Feedback

- | Feedback

€ | Feedback

€ | Feedback

€ | Feedback

Title Userinfo

Announcements

Patent Information

Search Methodologies

Patent Classification

Substantive Examination Tasks

Databases, Tools and Platforms for Patent
Examination Tasks

Technology-specific Training

Other Training Needs

Further Observations

Click ‘Continue’ to proceed

Continue

Usually the imported course is a new course. So, under the header ‘Restore as a new
course’, click the category corresponding to the course (in this case, it is Prior Learning),

then click ‘Continue’.

The imported course may also be a new course replacing an existing course. If that is the

case, under the header ‘Restore into an existing course’, choose either the new course will
be merged into the existing course, or replace by deleting the existing course. Choose the
course intended to be replaced, and then click ‘Continue’.
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1. Confirm » 2. Destination » ttings » 4 > siew » >

Restore as a new course

Restore as a new course @

Select a category Name Description

Miscellaneous

® Prior Leamning Any course related to recognition of prior
is in here,

Choose the category, then
click ‘Continue’

Continue

Restore into an existing course O ~
N/

Merge the backup course @
into the existing course

Delete the contents of the
existing course and then
restore

Select a course Course

short name Course full na Choose the course to be

Training Individualized arf replaced, then click
Management Patent Examined ‘Continue’

Search

Continue

Choose whether importing the course would also import several items in the original course.
By default, everything is also included in the import. Click ‘Next’ to proceed.
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1. Confirm » 2. Destination » 3. Settings » 4

Restore settings

Include enrolled users

Include enrolment methods

Include user role assignments

Include activities and resources

Include blocks

Include filters

Include comments

Include badges

Include calendar events

Include user completion details

Include course logs

Include grade history

Include groups and groupings

Include competencies

Cancel

The imported course has its own details (hame, start date), but administrator is free to edit
them. Click ‘Next’ to proceed.
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Course name | WIPO Self-assessment of Individ
Course short name Training Needs Self-assessme

Course start date v | February 2018 v E&

Select All / None (Show type options)

Questionnaire User data
Announcements =
Patent Information @-|
Search Methodologies § |
Patent Classification |
Substantive Examination Tasks §-|

Databases, Tools and Platforms for
Patent Examination Tasks(i H

Technology-specific Training § i

Other Training Needsi |

Further Observations §-|

Previous Cancel

Click ‘Perform restore’ to proceed.
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Course name \WIPO Self-assessment of Individual Examiner Training Needs
Course short name  Training Needs Self-assessment

Course start date  Thursday, 1 February 2018, 12:00 AM

Questionnaire User data
Announcements |
Patent Information § |

Search Methodologies § |

Patent Classification § |

Substantive Examination Tasks s‘ i

Databases, Tools and Platforms for
Patent Examination Tasks ‘t |

Technology-specific Training § |
Other Training Needs § |

Further Observations § i

Previous Cancel Perform restore

Click ‘Continue’ to proceed.

1. Confirm » 2. Destination » 3. Settings » 4. Schema » 5. Review & 6. Process » 7. Complete

restored successfully, clicking the continue buiton below will take you to view the course you

Continue

The questionnaire can now be answered by users.
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T
Questionnaire

A self-assessment questionnaire for each participant

Announcements
hﬁ H Patent Information

$ ¥ search Methodologies

| | patent Classification

i i Substantive Examination Tasks

“_ﬁ H Databases, Tools and Platforms for Patent Examination Tasks
G{ i Technology-specific Training

“—{ i Other Training Needs

i
(ﬁ H Further Observations

ADDING / MODIFYING COMPENTENCIES OF A COURSE

ENROLLING A USER TO A COURSE

Once a course has been created, an administrator can enroll a user to the course. Open the
course page and click the desired course:

Manage courses

Search courses
Dashbo
= Site home
b Stte pages Miscellaneous
v Courses

¥ Miscellaneous - z
Prior Learning ~ Prior Learning

=i b

b Site administration

Search

On the course page in the ‘Administration’ block, there will be a header called ‘Course
administration’. Go to Users > Enrolled users.
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Dashboard Courses Prior Learning Training Needs Self-assessment Turn editing on

Your progress @

Questionnaire

A self-assessment questionnaire for each participant

=l Announcements
“‘ i Patent Information

i i Search Methodologies

i i Patent Classification

% i Substantive Examination Tasks
L E ? Databases, Tools and Platforms for Patent Examination Tasks
methods

@ Groups

“{ Technology-specific Training
» Permissions al
) “‘, ! Other Training Needs
P. Other users )
-
f “{ { Further Observations
b Reports
£} Gradebook setup
} Badges

Ty Backup
¥+, Restore
¥, Import
@ Publish
&) Reset

P Question bank

The main title will display how many enrolled users for the course. In this example, currently
there is no user enrolled. To add / enroll users, click ‘Enrol users’.

WIPO Self-assessment of Individual Examiner Training
Needs: 0 enrolled users

Number of enrolled users at the
Dashboard Courses Prior Learning Training Nee moment

Enrolled users

ADMINISTRATION

w Course administration
Search Enrolment methods Al v Role Al

£¢ Edit settings

#° Turn editing on Group Allpartic v Status Al 4 Reset

£+ Course completion

v Users
A
#, Enrolled users First name / Sumname* / Last access Roles Groups Enrolment

- mail m r
Enrolment Email address to course methods

methods

i} Groups

» Permissions E
ermissions Enrol users

2. Other users
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A pop-up will appear, listing available users to be enrolled to the course. Administrator can
also simultaneously assign roles to the user, e.g. student, teacher, and manager. Other than
enrolling individual users to the course, administrator can also enrol a cohort to the course by
choosing ‘Browse cohorts’ instead of ‘Browse users’. Click ‘Enrol’ for each user / cohort.

WIPO Self-¢ — aining
Needs: 0 en — 0" US€rs

Dashboard » Courses | Assign roles = Student
Choose either to enrol by users
& Browse users Browse cohorts or by COhOI’tS

»  Enrolment options

Search
Enrol users

3 users found
w Course administration Examiner AAA
% Edit settings examiner.aaa@yada.com
# Turn editing on Examiner BBB
£ Course completion examiner.bbb@yada.com
" Users Admin User

#. Enrolled Sofiarehan L , Groups Enrolment
Dt Click ‘Enrol’ for each user e

Enrolment

Enrol users

» Reports

£ Gradebook setup

) Badges

Ty Backup
Click ‘Finish enrolling
users’ to proceed Finish enrolling users

Note: A user can also enroll himself / herself if self-enrolment is enabled for a course.

The course now will be updated to list the enrolled users.
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Dashboard Courses

w Course administration
£ Edit settings
# Turn editing on
£ Course completion
v Users
J. Enrolled users
b Enroiment methods
8 Groups
b Permissions
3. Other users
Y Filters
b Reports
£ Gradebook setup

b Badges

¥ Restore
o Import

@ Publish

earning

Training Needs Self-assessment Users

Enrolled users

Search

Status Al

Group All partic v

First name / Sumame™ / Last
Email address access
to
course
Never

Examiner AAA Student X

examiner.aaa@yada.com

Examiner BBB Never  Student X{

examiner.bbb@yada.com

Enrolment methods Al

Enrolled users

Enrol users

v Role

Roles Groups Enrolment methods

Manual enrolments
from Tuesday, 23
January 2018, 4:11
PM L X
Manual enrolments
from Tuesday. 23
January 2018

PM & X

Enrol users
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9. REPORTS IN MOODLE
10. REVIEWING COMPETENCIES

VIEWING REPORT AND GIVING RATING OF ENROLLED USERS

An administrator, a teacher and other permitted users can view report of each enrolled users
in a course. With Moodle, the reports can be broken down according to competencies linked
to the course. Under ‘Course administration’, go to Reports > Competency breakdown.

WIPO Self-assessment of Individual Examiner Training Needs

Dashboard ourses Prior Learning Training Needs Self-assessment Turn editing on

Your progress (@

Questionnaire

A self-assessment questionnaire for each participant

+ Course administration

b Users
Y Filters

v Reports

Report is broken down according to competencies relevant to the course, and also displayed
for each user who is taking the course.

If a teacher / manager is satisfied in the user’s performance in the course, the teacher /

manager can indicate that the user is competent by giving the appropriate rating for each
competency. To rate the user, click the word ‘Not rated’ for the competency to be rated.
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Dashboard Courses

Dashboard
= Site home
b Site pages

v C es

w Prior Learning

_ Training Needs
Self-assessment

icipants

» Questionnaire

P Miscellaneous

w Course administration

=d

it settings

# Tumn editing on

A pop-up window will appear, indicating that at the moment the user is not proficient in the

Prior Learning

Training Needs Self-assessment

Examiner AAA

m Message

Competency breakdown

ompetency ratings in this course are updated im|
Competency Rating
Work-Sharing 8 Not
rated

ches and Patent Not

competency, and also no rating has been given.

Reports

Competency breakdown

Examiner AAA
|

4 Add to your contacts

Examiner BEB

«

Click this arrow to switch
between users

the competency

Click here to change the rating of

Reports

User competency summary

| Work-Sharing

Path: Training for Patent Examiners

: Cross-referenced competencies:

No other competencies have been cross-referenced 1o this competen

Activities

User

Examiner AAA

Proficient

[NoJ

' Rating

Rate

Evidence

No evidence

To give rating to the user, click the word ‘Rate’. Another pop-up window will appear, and in

this window, the teacher / manager can give rating (either competent or not yet competent),

with evidence notes.
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User competency summary

Work-Sharing

Path: Trainir E
Cross-referenced compel

Rating

Choose a rating
Activities

User

Proficient

[NoJ

Rating

Rate

Evidence
evidence

User competency summary

Work-Sharing

Cross-referenced compet
Rating
Competent
Activities
Evidence notes
User

This user has successfully completed this course

Proficient

Rating m Cancel

Rate

Evidence

After that, the user is indicated as proficient in the competency, with a ‘Competent’ rating.
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User competency summary

Work-Sharing

Path: Training for Patent Examiners

Cross-referenced competencies:

No other competencies have been cros ferenced to this competency

Activities

No aclr

Rating

Competent = Rate

Evidence

Admin U
Thursday, 25 January 2018, 4:32 PM

The competency rating was manually setin the course ‘Course: WIPQ Sel-assessment of Individual Examiner Training Needs

This user has successfully completed this course

Consequently, in the competency breakdown report, the particular competency for the user is
rated as ‘Competent’.

or Learning Training Needs Self-assessment Reports Competency breakdown

Examiner AAA

Dashboard
Site home
Site pages
Courses
~ Prior Learning Competency breakdown

_ Training Needs
K Self-assessment

® Message + Add to your contacts

Competency
Work-Sharing 8
Questionnaire
P Miscellaneous Undertake Searches and Patent Not rated

within a Nationa

ndependenth
+ Course administration Searches and Exar

£k Edit settings Mational C
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FOR USERS: SUBMITTING EVIDENCE OF PRIOR LEARNING

Since there are competencies that are not relevant to any of the available courses,
examiners can submit own evidence indicating that they are already competent in that
particular competency. Administrators / Managers can also review this evidence and decide
whether the evidence is enough to demonstrate proficiency of the competency, or ask the
examiners to submit more evidence.

For a user to upload the evidence, go to the learning plan from the profile page. Click
‘Evidence of prior learning’.

Admin User

Profile Learning plans

Learning plans

Add new learning plan
b Site pages

List of learning plans

Name Template based Status Actions

[ Yes Active Edit ~

b Site administration

Search

This page will display all evidence of prior learning. In this particular example, the user has
never submitted any evidence. To upload evidence, click ‘Add new evidence'.
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Dashboard Profile Learning plans Evidence of prior learning

Evidence of prior learning

Dashboard
= Site home Add new evidence
} Site pages

b Courses List of evidence

Name Summary Linked competencies (Status / Reviewer) Actions

Search

In the next page, insert an appropriate title for the evidence to be uploaded, along with a
description of the evidence. It is also possible to include a URL for further reference. In this
example, the user has a Master in Intellectual Property, so he is uploading the certificate,
and a URL to the list of courses under the program.

Learning plans Evidence of prior learning Add new evidence

Evidence of prior learning
Dashboard
= e home Add new evidence

b Site pages

P Courses

General

Name *

Masters in IP Certificate Name of the evidence

» Site administration
Description

Search

| took Masters in IP in University XXX in 2010. The list of courses taken are in the URL below

\ Short description

regarding the evidence

URL for reference (if any)

fuw/documents/brosur. pdf
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Maximum size for new fies: Unimited

oo

Evidence

Click to proceed

After saving the changes, the uploaded document(s) will be displayed. To link related
competencies to this evidence, click ‘Link competencies’.

Profile Learning plans Evidence of prior learning

Masters in IP Certificate #

home < Link competencies
b Site pages
b Courses | took Masters in [P In University X3¢ in 2010. The list of courses taken are in the URL below
ukm.my/fuu/de ents/brosur

ertificate - Admin User.jpg

Linked competencies

» Site administration
Name Status / Reviewer Actions

Search

A pop-up window will appear, showing the competencies listed under the assigned learning
plan. The user can click the competencies that are related to the evidence submitted.
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Admir *°

Learning plans

Competency picker

Training for Patent Examiners Level 1
Locate competency
w+ Training for Patent Examiners Level 1

Nature and function of IP rights L

Function of international and natidpal IP offices

Laws, treaties and conventions govkming international and

national patent systems

_ Click the relevant competency;
P hold ‘CtrI’ button to choose more
= : than one competency

Search

Add

Cancel

Once added, the linked competencies will be displayed under the evidence submitted.

Dashboard Profile Learning plans Evidence of prior learning C

Masters in IP Certificate =

Dashboard

Masters in IP Certificate

= Site home <= Link competencies
b Site pages

b Courses | took Masters in IP in University XXX in 2010. The list o

To edit submitted evidence,
click the gear next to the title

b Site administration

Search Nature and function of IP rights

Status /
Reviewer Actions

reaties and conventions governing international and national

patent systems
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The user can request for the evidence submitted to be reviewed. In order to do so, go to
Profile > Learning Plans > Evidence of prior learning. Or from the page earlier, click the word
‘Evidence of prior learning’ tab.

Click ‘Edit’ under the ‘Actions’ tab, where a drop-down menu will appear. Choose ‘Send
competencies for review’.

Learning plans Evidence of prior learning

Evidence of prior learning

Dashboard

= Site home Add new evidence

» Site pages

b Codres List of evidence

Summary Linked competencies (Status / Reviewer)

Nature and function of IP rights 1.1 (-)
Laws, treatiesand c¢ _, _
b Site - : £ Edit this evidence
» Site administration sters in e tional and national pi

& Send competencies for review

Search

FOR TEACHERS / MANAGERS: REVIEWING EVIDENCE OF PRIOR LEARNING

Anybody with the capability to view learning plans can see which users have requested
reviews and for which competencies.

Dashboard - _ No files available

= Site home
Training for Patent Examiners Level 1 Manage private files

b Site pages
b Courses “ompetencies to review Competencies that
reaties and cor s goverr , | need to be reviewed

and national patent systems

review

(last & minutes: 1)

- o~ : Admin User
Nature and function of IP rights (Admin User) - Waiting for AL

review
b Site administration

Clicking the competency will open the competency and list of evidence to be reviewed
submitted by a user.
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Dashboard Profile Learning plans Laws, treaties and conventions governing international and national patent systems

Laws, treaties and conventions governing international and national
patent systems - - T
Dashboard Training for Patent Examiners - Competency Click ‘Start review’ to indicate to
= Site home the user that the evidence is in

Path: Training for Patent Examiners / 1

ZASEe pages Cross-referenced competencies: reviewing process

b Courses
No other competencies have been cross-referenced to this cgmpetency

Review status

Waiting for review ~ Cancel review request Start review

Proficient

b Site administration

Rating
rae<—— | Click here to rate the proficiency
Search of the user in terms of the
y comments () particular competency
Evidence

Clicking the link in the evidence
will direct the user to the
evidence page

Admin User
Friday, 26 January 2018, 2:19 PM
The evidence of prior learning 'Masters in IP Certifica

hitp:/flocalhost/admin/tool/ip/user_evideffcé php7id=

Similar to reviewing competency breakdown report, each user can be rated either competent
or not yet competent for each competency.

Laws, treaties and conventions governing international and national
patent systems

Training for P Examiners - Competency

Path’ Trainina far Patant Fvaminare (1

Rate

Rating

Choose a rating v

t competent
petent

Site administration

Search

Evidence

The user is now proficient in the particular competency and the administrator / teacher can
click ‘Finish review’ to finish the process.
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Dashboard Learning plans Laws, treaties and conventions governing international and national patent systems

Laws, treaties and conventions governing international and national
patent systems

Dashboard Training for Patent Examiners - Competency

Site home
Path: Training for Patent Examiners / 1

b Site pages ;
Ay Cross-referenced competencies:

Courses
MNo other competencies have been cross-referenced to this competency
Review status
In review - Admin User = Finish review

Proficient
b Site administration

Competent Rate

Search

P Comments (0)
Evidence

Admin User
Friday, 26 January 2018, 4:12 PM
Competent

The competency rating was manually set

Admin User
Friday, 26 January 2018, 2:19 PM
The evidence of prior learning 'Masters in IP Certificate’ was linked

http:/flocalhost/admin/tool/lp/user_evidence.php?id=1

The below screenshot is what the user who requested for his evidence to be review would
see in his ‘Learning plans’ page. One of the competencies has been rated competent.
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Training for Patent Examiners Level 1

Dashboard
= Site home For newly-recruited patent examiners

b Site pages atati
Active (Complete this learning plan)
Learning plan template
Training for Patent Examiners Level 1 (Unlink from learning plan template)
Progress

1 out of 4 competencies are m

proficient

b Courses

b Site administration

mments (0)

Learning plan competencies

Name Rating Proficient Status Actions

Nature and function of IP rights 7.1 No Waiting Edit

Path: Training for Patent 5 / for
review

s, reaties and conventions governing Competent
nternational and national patent systems 1.3

Path: Training for Paten

Function and processes of patent examination and
the role of patent examiners 1.4

Path: Training for Paten
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11. WORKAROUNDS IN MOODLE

Although at first glance it seems that Moodle is more geared towards blended online
learning, it is easy to customize Moodle to be a useful LMS tool. These topics below will
address some of the needs that can easily be achieved in Moodle.

COMPILING DATA OF EXAMINERS

In a patent office, often the number of trainings attended serves as a performance indicator
of an examiner for a manager. A manager sometimes needs to know the trainings that an
examiner has attended in order to determine the career path of the examiner, or to determine
eligibility of the examiner to be nominated to another training course.

In Moodle, this can be incorporated in the form of a course. For example, a course entitled

“Previous courses attended” can be created, where all courses attended by examiners per
year can be compiled, and the data can be downloaded in .csv or .xlIs format.

Creating a New Course

Go to Site administration > Courses > Manage courses and categories.

Click the category for the course, then click ‘Create new course’. In this example, this new
course will be under the ‘Prior Learning’ category.

Prior Learning

'O Self-assessment of Individual Examiner Training Needs

Move selected courses to...

Choose v Move

Put the appropriate full and short names for the course.
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Dashboard Site ad 1 Courses Manage courses and categories Add a new course

Add a new course

= Site home

b Site pages ~ General

Course full name *

List of Courses Atte

Course short name *

PrevCourses

Course category

Prior Learning v

Course visibility

Show v

Course start date (2

¥ | February
ninistration

Course end date
Registration

§ Advanced features ] F @ 2019 YEY @ Enable

Course ID number
£# Manage courses
and categories

It is recommended that topics format is chosen for this course. However, administrators /
managers are free to choose any other appropriate format.

r Category: Prior Learning
* Manage this cate
=dit this category
= Add a subc

Number of sections

Hidden sections

15 are shown in collz

Course layout

Show

¥ Regisira
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Click ‘Save and return’ to continue.

The course is now listed under the selected category. To add content to the course, click the
name of the course.

Prior Learning

Create new course | Sort courses~ | Per page: 20~

List of Courses Attended

ment of Individual Examiner Training Needs

When a course is first created, the content will be empty. To add content, firstly editing must
be turned on.

List of Courses Attended

Dashboard Courses Prior Learning PrevCourses

Courses
+ Prior Learning
v PrevCourses

Miscellaneous

After editing is turned on, an activity or resource can be added in each topic. Click ‘Add an
activity or resource’ to proceed.
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List of Courses Attended

Courses Prior Learning PrevCourses Turn editing off

Announcements Edit~ X
Dashboard

= Site home == Add an activity or resource

b Site pages

+ Prior Learning
* PrevCourses

== Add an activity or resource

A pop-up window will appear, where various types of activities can be selected. Choose
‘Database’, then click ‘Add'.
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Add an activity or resource

List of Cours

ACTIVITIES The database activity module enables

Assianment participants to create, maintain and search Turn editing off
ssignment ekt

a collection of entries (i.e. records). The
Chat structure of the entries is defined by the

ol teacher as a number of fields. Field types
hoice
include checkbox, radio buttons, dropdown

menu, text area, URL, picture and uploaded
file

ternal tool
The visual layout of information when

Prior Learning Feedback listing, viewing or editing database entries

o i b i e e e
PrevCourses Faiten may be controlled by database templates

Janis : Database activiies may be shared between
Glossary courses as presets and a teacher may also
importand export database entries
Lesson
If the database auto-linking filter is enabled
Quiz any entries in a database will be

SCORM package automatically linked where the words or
phrases appear within the course
| Survey

Ateacher can allow comments on en
I resource
Wiki Entrigs can also be rated by teachers or

students (peer evaluation). Ratings can be

b ‘ Workshop

aggregated to form a final grade which is

recorded in the gradebook
RESOURCES ; e
or resource

Database acfivities h many uses, such
I Book

as L N
== Add i
File Acollaborative collection of web links,

Cancel

As usual, put a title for the activity, and any other appropriate settings for the database. Click
‘Save and display’ to proceed.
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¥ Expand al
Dashboard Expand all

- General

t of Courses Attended in 2018

Description

For a database type of activity, the admin / manager must define the fields that a user needs
to fill out. Therefore by default currently there are no fields defined. Assuming the first item in
the database would be the course name, choose ‘Text input’ from the dropdown menu.

List of Courses Attended

Site pages
w Courses
* Prior Learning
* PrevCourses

v or choose a predefined set to get started

Help with Create a new field 1

List of me added 1 B Save
~ Courses p

Attended in

2018

Put the item name, and indicate it as a required field. Click ‘Add’ to save and continue.
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List of Courses Attended

View single Search Add entry

Text field
Field name Course Name

Field description

Required field #
Allow autolink

Cancel

If the field that needs to be keyed in by examiners is related to dates, choose ‘Date’ as the
new field, and proceed as above. Similarly, a field relating to ‘File’ can also be added via
similar method (for example, the user needs to upload the program of the training). A basic
database would have fields like shown below.

List of Courses Attended in 2018

View single Search Add entry Export Templates Fields

Field name Field type Required Field description Action
Course Name E= Textfield Yes

Place E= Textfield Yes

Organizers = Textfield

Start Date @ Date field

End Date B Date field

Programs o File field

Create a new field Choose

Default sort field

Time added Ascending
o
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Templates tab is the place where the display of records (either a single item or the whole list)
can be customized. If the admin or manager would like the list to be presented in table
format, it is recommended to key in this in each of the respective box (and disable editor
first):

Header:

<table style="width: 100%;" border="1" cellpadding="5">
<tbody>

<tr>

<td><b>Course Name</b></td>
<td><b>Place</b></td>
<td><b>Organizers</b></td>
<td><b>Start Date</b></td>
<td><b>End Date</b></td>
<td><b>Program</b></td>
<td><b>Name</b></td>

</tr>

Repeated entry:

<tr>

<td>[[Course Name]] | ##edit## ##more## #delete##</td>
<td>[[Place]]</td>

<td>[[Organizers]]</td>

<td>[[Start Date]]</td>

<td>[[End Date]]</td>

<td>[[Program]]</td>

<td>##user##</td>

</tr>

Footer:
</tbody>
</table>
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List of Courses Attended in 2018

View list View single Search Add entry Export @ soa
@ Single template Advanced search template Add template RSS template

CSS template Javascript template

Defines browsing interface for multiple entries

Header

<table style="width: 100%." border="1" cellpadding="5">
<tbody>

_ourse Name</td>

Therefore, if there are entries added in the list, they would be shown in table format as
follows. The list can also be exported via the ‘Export’ tab.

List of Courses Attended in 2018

Entries per page 11 ¥ Search Sortby  Time added Ascendin Advanced search | Save seftings

Course Name Place Organizers | Start Date End Date Program Name

Geneva |WIPO 2 January 2018 | 4 January 2018

g Program A F BT 1 February
Australia | IP Austraka | _
2

Train the Trainers | ¢ ©

From an enrolled user’s perspective, he/she can add and view entries, as shown below.
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List of Courses Attended in 2018

View single

New entry

-

Course Name

Train the Trainers

Organizers

Start Date . v!|| February

End Date E =

February

Maximum size for new files: SMB, maximum attachments: 1

Program for Train the

Save and view Save and add another

Creating Similar Courses for Previous Years

Similar steps could be taken to create list of courses attended by examiners for other years.
A shorter way to do this is by saving the table created in the first course as a preset, and
repeat using it for other similar courses. To save the format as a preset, click the ‘Presets’
tab.

Under the Save as preset, give a name for the preset, then click ‘Continue’.
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List of Courses Attended in 2018

View single Search Add entry Export Templates Fields

Export

Export as zip

Export

v Save as preset

Name *

List of Courses Attended

Overwrite @ Overwrite the preset if it already exists

Continue

There are required fields in this form marked *

A notification will show that the preset has been saved.

——_—_—_—
Dashboard Courses Prior Learning PrevCourses Courses Atiended in 2018 List of Courses Attended in 2018 Presets

sing Search € Ex ate is resets
b Site pages
v Courses Saved successfully. Your preset will now be available across the site
Prior Learning
* PrevCourses
Continue

To use the preset, add a database activity under to topic ‘Courses Attended in 2017’, similar
to what have been done for the previous activity.
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Edit~ 8

Announcements -

dd an activity or resource
Add an activity or resource

% Courses Attended in 2018

Edit~ &

s List of Courses Attended in 2018

= Add an activity or resource

# Courses Attended in 2017

an activity or resource

% Courses Attended in 2016

= Add an activity or resource

# Courses Attended in 2015 and below Edit v
== Add an activity or resource

== Add topics

Again, similar warning appears where no fields are defined in the database. However,
instead of creating all fields one by one, now click the ‘Presets’ tab.

Dashboard Courses Prior L ng PrevCourses Courses Attended in 2017 List of Courses Attended in 2017

List of Courses Attended in 2017

Dashboard View list  View single Search  Add entry Export
= Site home

b Site pages

v Courses

¥ Prior Learning

w or choose a predefined set to get started

Create a new field Choose

Courses Default sort field

b %teﬁde"f in Time added Ascending v Save
2018
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Scroll down until the header ‘Use a preset’. The preset that has been saved earlier is now
available under the preset. Choose the preset to proceed.

+ Use a preset

Image gallery

® List of past courses attended (Admin User) X

Choose

The preset fields are now available. If there are no changes in the preset fields, click
‘Continue’.

List of Courses Attended in 2017

View single Search Add entry Templates

Field mappings ®

Course Name new field

Organizers Create a new f

Start Date

End Date

All old fields not mapped to a new field will be lost and all data in that field will be removed

Overwrite current settings

Continue

Now any enrolled user can key in the required data to be compiled.
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List of Courses Attended in 2017

\

View single  Search ~ Add entny

New entry

Course Name: *

Place

Organizers

Start Date v February

End Date 5 ¥  February

Save and view Save and add another
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MATCH COMPETENCIES OF A USER AND A COURSE

Generally, each user will have his / her own learning plan, in which the user has to be
proficient in all competencies in the learning plan in order to mark the learning plan as
complete. Therefore it would be a good idea to facilitate a situation where a user wants to
find out a course that will help the user achieves that completion. The system could
recommend a course based on the competencies that the user is not yet proficient.

Currently, Moodle allows a user to find a course that is relevant to one competency. This can
be done by going to Profile>Learning plans. Click the learning plan.

Leaming plans

Learning plans

s Site home Add new leaming plan
b Site pages
A SO List of learning plans
PrevCourses
» KPI Name Template based Status Actions

» Assessment - - ) —= . .
Training for Patent Examiners D o Active Edit -

Site administration

The list of competencies under the learning plan will be displayed. Click ‘Edit’ at the right of
the competency, then click ‘Find courses’ to find courses that are relevant to the
competency.
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Training for Patent Examiners Level 1 »

Dashboard

» Site home <} Add competency
» Site pages
« My courses For newly-recruited patent examiners

» PrevCourses Status

» KPI Active (Complete this leaming plan) (Send back to draft)
» Assessment Progress

2 out of 16 competencies are m

proficient

ap— » Comments (0)

e ——— Learning plan competencies

Name Rating Proficient Status Actions

4 Nature and function of IP rights 1.7 Competent  Yes - Edit ~
Path: Training for Patent Examiners / 1 .
&+ Request review
% Function of international and national IP offices 1 - No| X Delete
Path: Training for Patent Examiners / 1

< Laws, treaties and conventions govemning Competent
intemational and national patent systems 1.3

Path Training for Patent Examiners / 1

4+ Function and processes of patent examination and
the r f patent exami §

Path Training for Patent Examiners / 1

A pop-up will show the list of courses that are relevant or linked to the competency.

Examiners /

Linked courses
Courses inked to this competency

1. WIPO Self-assessment of Individual Examiner Training Needs Training Needs

Self-assessment

Path: Training for

Currently it is only possible that users can find courses that are linked to one competency.
However it is possible to cross link one competency with another competency, so indirectly
the user can find a course that is linked to the competencies that he / she is not yet
proficient.
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USING PLUGINS

One of the advantages of using Moodle is the freedom to add plugins to complement the
existing features found in Moodle. Directory of plugins that can be used can be found here:
https://moodle.org/plugins/. There are several functions that may be worth having in the LMS
for patent examiner training that can be achieved by installing plugins, as will be shown
below.

Match Course with user profile fields

As shown earlier, custom profile fields can be made in Moodle. In the previous examples, a
user can input a certain criteria in his / her profile field, e.g. IPC related to the technology
field, recruitment date as a patent examiner, technical background etc. It would be an
advantage if the user can filter courses according to these fields, e.g. a course that only
users with a background in Biotechnology can enroll.

While by default this cannot be done in Moodle, this plugin allows the workaround of such
feature: https://moodle.org/plugins/enrol_attributes. Click the ‘Download’ button to download
(remember to check that the plugin is compatible with the Moodle version installed).

nt: Enrol by user Release 2.4.2 for

y ;‘| c | 'iC Moodle 2.7-3.3 (build
proi e Tields 2017050100)
Moodle 2 2 99

Search plugins

ir Moodle version

code prechecks 131 | 72

To install the plugin, go to Site administration > Plugins > Install plugins. Then drag the
downloaded zip file of the plugin to the box under ‘Install plugin from ZIP file’. Alternatively,
the plugin can be installed directly from the Moodle plugins directory. Then click ‘Install plugin
from the ZIP file’ to proceed.
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Dashboard Site administration Plugins » Install plugins Blocks editing on

Plugin installer

Dashboard

» Site home

» Site pages

« My courses Install plugins from the Moodle plugins directory
» PrevCourses
» KPI

b Assessment

~ Install plugin from ZIP file

ZIP package =

v Site admi =
e Choose a file
£+ Notifica

¥ Reg

% Advanced features Drag the zip file to this box

» Users

Courses
= lag ’ .
Grades You can drag and drop files here to add them
Competencies
Badges
» Location

Language

Plugins

nstall plugins C“Ck to proceed

£# Plugins overview

Follow the instruction to install the plugin.

Individualized and Competency based Patent Examiner Training
Management

Install plugin from ZIP file

Validating enrol_attributes ... OK

ssful, installation can continue
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Plugins check

Check for available updates
Plugins requiring attention
Cancel new installations (1) = Plugins requiring attentic

Plugin name [ Directory Current version New version Requires Source | Status

Enrolment methods

Enrol by user profile fields 2017050100 .

Cancel this installation

Upgrade Moodle database now

Upgrading to new version

enrol_attributes

In the next page, choose profile fields that may be used to enroll people. To make all fields
available as criteria for enrolment, choose all by clicking ‘CtrI’ while selecting the field. Then
click ‘Save changes’ to proceed.

The settings shown below were added during your last Moodle upgrade. Make any changes necessary to the defaults and then click the "Save changes™ button at the
bottom of this page

New settings - Enrol by user profile fields
Default role Student v
Default role used to enrol people with this plugin (each instance can override this
Profile fields to be used in the

selector | ¢ weamnee | HoOID ‘Ctrl” while selecting to
echnical Qu: select more than one field

n configuring an enrc instance?

If you don’t select any role here, this makes the plugin moot and hence disables its use in courses.

The feature below may however still be used in this case
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To enable enrolment by user profile field, go to Site administration > Plugins > Enrolments. If
the plugin was installed and configured successfully, the option ‘Enrol by user profile’ will be

listed (although by default it is not yet enabled). To enable the method, click the slashed eye
icon.

Dashboard Site administration Plugins Enrolments Blocks editing on

Category: Administration / Plugins / Enrolments

=ite home

» Site pages Manage enrol plugins

= M courses

» KPI Available course enrolment plugins

Instances / Test
_____ Name enrolments Version Enable Up/Down Settings settings Uninstall
Badge Enrolment 110 2015120300 @ J Uninstal
Manual enrolments 6/ 11 2017051500 @ ~d Settings
Guest access 6/0 2017051500 @ A J : .
Self enrolment 6/0 2017051500 @ + ¥ This enrolment method

is not yet available.
/ Click here to make this
method available

Cohort sync 0/0 2017051500

Once it is enabled, the item will not be greyed out. To prioritize this enrolment method, move
the method by clicking the upward arrow.

Dashboard Site administration Plugins Enrolments Manage enrol plugins Blocks editing on

Manage enrol plugins
o Available course enrolment plugins

« My courses

» PrevCourses

» KP

Instances | Test
Name enrolments Version Enable Up/Down Settings settings Uninstall

Badge Enrolment 2015120300
Manual enrolments 6 2017051500
Guest access 6 / 2017051500

Enrol by user profile 2017050100 @
fields

Self enrolment b / 2017051500

Cohort sync / 2017051500

To enable this enrolment method for a course, choose the course. In this example, the
course selected is only to be made available for examiners who examine applications related
to IPC Main Group H.
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Manage courses

» Prior Learning

- Miscellaneous

« Courses

field of Oplics >

» Site administration
» Feedback for a Course

Add a new course

Under the ‘Course administration’, go to Users > Enrolment methods.

Dashboard » Courses » Miscellaneous » Optics » Users » Enrolment methods

Enrolment methods

Dashboard
Site home Name Users Up/Down
» Site pages
» My courses
PrevCourses
» KPI
» Assessment
» Courses
v Miscellaneous Add method Choose
« Optics
» Participants
¥ Badges
& Competencies
™ Grades
» General
» Topic 1
» Topic 2
» Topic3
» Topic 4
worksharing
» Prior Learning
Feedback for a Course

Course administration is in the
+ Course administration ‘Administration’ block

&t Edit settings

p* Tum editing on

£+ Course completion
Users
». Enrolled users
» Enrolment methods

) Groups
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To add the enrolment method, click the downward arrow and choose ‘Enrol by user profile
fields’.

Dashboard Courses Miscellaneous Optics Users Enrolment methods

VIGATION ~“  Enrolment methods

Dashboard
« Site home Name Users Up/Down
» Site pages
+ My courses
» PrevCourses
» KPI
» Assessment
« Courses
+ Miscellaneous

Add method| Enrol by user profile fields v

» Optics -
Choose

» Participants Badge Enrolment

¥ Badges

A Competencies Self enrolment

M Grades _ Cohort sync
» General
» Topic 1
» Topic 2
» Topic3
» Topic 4

» worksharing
» Prior Learning
» Feedback for a Course

Give a name for the new course prerequisite, and make the right condition. In this example,
the IPC of the user must be exactly ‘H02J'. Additional condition can also be enforced by
clicking the plus icon.

Click ‘Add method’ to proceed.
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Enrol by user profile fields

~ Enrol by user profile fields

Custom instance name

Role

Student

User profile fields rules (&

Click any of these to
add / delete rules

Relevant IPC classes

Choose either
"< | "AND’ or ‘OR

Technical Qualification v - Engineering

Unenrol after attributes expiration (%)

This enrolment method is now available for this course. If there are multiple enrolment
methods available, those methods can be arranged according to priority by moving the

method up or down.

To enroll users via this method, click the pencil icon of the method to continue.

Enrolment methods

Name disable a method

Click the eye icon to enable /

IPC

Click the pencil icon to force
enroll users based on the
criteria

Add method Choose

Click the arrow to
move the method
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Click ‘Force enrolments now’ so any user that fulfils the criteria will be automatically enrolled
in the course.

Enrol by user profile fields

- Enrol by user profile fields
Custom instance name
Role
Student

User profile fields rules (@

Relevant IPC classes

OR

Technical Qualification = Engineering

Unenrol after attributes expiration (?)

Save changes Cancel Purge enrolments Force enrolments now

A pop-up will appear confirming the choice, click OK to proceed.
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- tpc x Jle Patents
The page at localhost says:

This will (re)enrol all users corresponding to this
rule.

af Optics

Opt Hds

rol by user profile fields

ol by user profile fields

om instance name

Another pop-up will appear, showing the number of users that will be enrolled by this
method.

lcome - | x Patents
The page at localhost says:

0K, 1 users have been enrolled

Prevent this page from creating additional dialogs.

ptics

OK

Enrol by user profile fields

This is also reflected when viewing the list of enrolled users of the course, as shown here
(Course administration > Users > Enrolled users).
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Enrolled users

Enrol users

Search Enrolment methods Al v Group All partic ¥

Status = All Filter Reset

First name / Surname* |/ Last Groups  Enrolment methods
Email address access
to
course
Admin User now Student Enrol by user profile fields
' enrolled Wednesday, 21
Sofiarehan. Ramli@wipo.int February 2018. 12:02 PM

Enrol users

However, as mentioned earlier, the enrolment criteria must exactly match the input of the
user profile field. For example, it would not work to enroll users who examine applications in
the main group H.

Additionally, so far there is no option of making this course optional to users who fulfilled the
criteria; instead the user will be enrolled by force.

Course Prerequisites

Another feature that would facilitate management of training of patent examiners in Moodle is
the ability to set prerequisites relating to competencies to a course. This is to ensure that all
participants in the course are on the same level of proficiency.

A helpful plugin to achieve this objective is called ‘Badge Enrolment’, and can be found here:
https://moodle.org/plugins/enrol_badgeenrol. The idea behind this plugin is that each badge
can be assigned to at least one competency, and a user has to have certain badges (i.e.
proficient in certain competencies) in order to be qualified to enroll into a course. (Information
about badges in Moodle can be found here: https://docs.moodle.org/33/en/Badges)

To install the plugin, go to Site administration > Plugins > Install plugins. Drag the
downloaded zip file from the Moodle site to the box with the blue arrow.
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Plugins Install plugins Blocks editing on

Plugin installer

Dashboard
» Site home

b Site pages

ins f 2 il & : firactons
* My courses Install plugins from the Moodle plugins directory

» PrevCourses

~ Install plugin from ZIP file

ZIP package =
Choose a file

enrol_badgeenrol_moo

Drag the ZIP file to this box, then
click ‘Install plugin’ to proceed

Install plugin from the ZIP file

£+ Install plugins

If everything is validated, proceed with installation by clicking ‘Continue’, then ‘Upgrade
Moodle database now'.

Install plugin from ZIP file

Validating enrol_badgeenrol ... OK

Validation successful, installation can c

Plugins requiring attention

Plugins requiring attention @9 Al plugins @3

Cancel new installations (1)

Plugin name / Directory Current version New version Requires Source | Status

Enrolment methods

Badge Enrolment 2015120300 .

Cancel this installation

™ Reload

Upgrade Moodle database now

Lastly, click ‘Continue’ to finish installation.
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Upgrading to new version

enrol_badgeenrol

After installation, go to Site administration > Plugins > Enrolments, and lick the eye icon for
the ‘Badge enrolment’ to enable this method.

Dashboard Site administration Plugins Enrolments Blocks editing on

SR Category: Administration / Plugins / Enrolments
s Site home

) Site pages Manage enrol plugins

* My courses

» PrevCourses

Available course enrolment plugins

Instances / Test
Name enrolments Version Enable Up/Down Settings settings Uninstall
ADMINISTRA ! Manual 6/11 2017051500 @ Settings

N enrolments

ns Guest access 6/0 2017051500 @ ™ Settings Uninstall
o Enrol by user 2/ 1 2017050100 @ - Settings Uninstall
- dpediaing profile fields

Courses Self enrolment 6/ 0 2017051500 @ Click the eye icon to enable this
. noetencias Cohort sync 0/0 2017051500 @ method of enrolment
> Locatior
L lanquage

Creating a Badge

In order to enroll users who have certain badges, first badges must be created. Go to Site
administration > Badges > Add a new badge. Fill out the compulsory details for the new
badge. It is recommended that the description clearly stated that which competency that
relates to the badge.

Do not forget to upload an image to be used as the badge.

Click ‘Create badge’ at the end of the page to continue.
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Dashboard Site administration Badges Add a new badge

- Badge details

Dashboard
» Site home
» Site pages Name =
+ My courses =
» PrevCourses Competency Level 1
» KPI

Optics Description »
) Assecement

This badge is for those who is deemed proficient in Competenct level 1

dministration
ications
gistration
£ Advanced features
» Users
Image =

» Courses

» Grades Choose a file

» Competencies

v Badges corporate-induction-180x180.png ] . -
& Badges seltings Drag an image file to this box

anage badges

£+ Add a new badge
» Location
» Language
» Plugins
» Security ~ |ssuer details

rance

| Name of the issuer of the badge |

Next step is to set up the criteria for the badge. Since this badge is independent of courses
taken previously, is must be manually issued. Click ‘Manual issue by role’ from the dropdown
menu.

Competency Level 1

Dashboard Site administration Badges Manage badges » Competency Level 1

{ Competency Level 1

Dashboard
» Site home Criteria for this badge have not been set up yet
» Site pages

Criteria = Message  Recipients (0)

v My courses Edit getails

» PrevCourses
» KPI Add badge criteria | Choose

To start adding critg - s from the drop-down menu

Choose the role that can issue the badge, and choose the option whether all of them must
award the badge to the user or any of them will do. Click ‘Save’ to proceed.
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Dashboard Site administration

Dashboard
Site home
» Site pages
» My courses
» PrevCourses
» KPI
» Optics

¥ Assessment

v Site administration

Badges Manage badges Competency Level 1 Manual issue by role

+ Expand all

~ Manual issue by role

¥ Manager
¥ Non-editing teacher
¢ Teacher
» This criterion is complete when...
All of the selected roles award the badge
= Any of the selected roles awards the badge

» Description

@ Cancel

Click ‘Enable access’ to

After access is enabled,

proceed.

badge issuers can select recipients to be awarded with this badge.

To award the badge to a user, click the ‘Recipients’ tab.

Site administration

Dashboard

= Site home
» Site pages
+ My courses

» PrevCourses

Badges » Manage badges » Competency Level 1

© Competency Level 1

This badge is currently not available to you want users to eam this badge. (@

Criteria

Add badge citeria | Choose Cllck here to VIeW / add
/ remove recipients of
this badge

This badge has to be awarded by the users with ANY of the following Toles
« Manager
« Non-editing teacher
« Teacher

Manual issue by role @

Click ‘Award badge’. On

the next screen, if there is more than one role that can award the

badge, choose the role from the dropdown menu.
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Dashboard Site administration Badges Manage badges Competency Level 1

O Competency Level 1

Site home 3 _ z 3 ;
i This badge is currently available to users. Disable access to make any changes. (@ Disable access

b Site pages

+ My courses g

d Message Recipients (0)

» PrevCourses

» KPI

b Optics Award badge

r Assessment

s not been eamed yet

Dashboard Site administration Badges Manage badges Competency Level 1 Badge recipients

Please select the role you would like to use to award this badge: | Choose v

Choose...

N “Choose |
Dashboard Manage

» Site home Teacher

» Site pages Non-editing teacher

LA

Click the intended recipient, then click ‘Award badge’. Similar steps are also applicable for
revoking a badge from a user.

Badge recipients

Site home Please select the role you would like to use to award this badge: = Manager v

Site pages Existing badge recipients ard bagac Potential badge recipients (3)
+ My courses g Examiner AAA aminer
¢ PrevCourses XA BB (examine
T Revoke badge »
9 r\'—"

Optics

Search Search

Search options »

All awarded badges will be displayed on the profile page of the user, as shown below.
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Admin User

Dashboard Profile

NAVIGATION ; User details
Dashboard Edit profile
Site home z
Site Email address

pages Sofiarehan. Ramli@wipo.int
My courses

» PrevCourses Date of Birth

» KPI 26 February 1982

» Optics

Start date as a Patent Examiner
16 January 2006

» Assessment

Relevant IPC classes
Ho2J

Site administration
Technical Qualification

BSc. in Electrical Engineering (majoring in
Power)

Badges from Individualized and Competency
based Patent Examiner Training Management:

g

Competency Level 1

Reset page to default

Miscellaneous
Blog entries

Notes

Forum posts
Forum discussions

Leaming plans

Reports
Today's logs
All logs

Outline report

Browser sessi
Grades ove

Grade

Login activity

M{st access to site

Customise this page

Nesday, 9 January 2018, 1:51 PM (43 days 20

Thysday, 22 February 2018, 10:13 AM (13

Saes)

Last IP address
0:0:0:0:0:0:0:1

Set badges as a course prerequisite

Now the badge can be set as a prerequisite to an existing course. To go to the desired
course, go to Site administration >Courses > Manage courses and categories. Choose the

course and click ‘View'.
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Substantive Examination training in the field of Optics

View | Edit | Enrolled Hide | Backup | Restore

Full name Substantive Examination training in the field of Optics

Short name Optics

ID number

Category

Groupings

Groups

Role assignments Student: 2

Enrolment methods IPC
Enrol by user profile fields

Badge Enrolment

Under the Course administration, go to Users > Enrolment methods.

Click the gear icon next to ‘Badge enrolment’ to change the settings for this enrolment
method.
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Dashboard Courses Miscellaneous Optics Users Enrolment methods

~  Enrolment methods
Dashboard
» Site home Name Users Up/Down
» Site pages
v My courses 0
» PrevCourses
» KPI
» Assessment
v Courses
v Miscellaneous

v Optics

> Pa:‘ficipaﬂtﬁ Click the gear icon to
¥ Badges change the setting

& Competencies

| Grades Badge Enrolment 0 PR \ 2

» General
Topfc 1 Enrol by user profile
fope2 fields
» Topic 3
» Topic4
» worksharing Add method = Choose
» Prior Leaming

Feedback for a Course

» Course administration
£ Edit settings
2" Tum editing on
£ Course completion
» Users

#, Enrolled users

v Enrolment methods

Click the badge(s) required for a user to qualify to enroll in the course, then click ‘Save
changes’.
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Dashboard » Courses » Miscellaneous » Optics » Users » Enrolment methods » Badge Enrolment

Badge Enrolment

Dashboard
i S o ~ Badge Enrolment
» Site pages
+ My courses
» PrevCourses Custom instance name
Badge Enrolment
» Assessment
v Courses
v Miscallaneatis Required site badges for enrolment
+ Optics Dmpe | evel
» Participants
¥ Badges
A Competencies
[ Grades
» General
» Topic 1
» Topic 2
» Topic 3
» Topic 4
» worksharing
» Prior Leamning Default assigned role

» Feedback for a Course Student

» Course administration

£+ Edit settings

Therefore, a user who has the badge can enroll into the course, while a user who does not
have the badge will not be able to enroll into the course. A screenshot of a user with and
without the required badges are shown below.

Dashboard » Courses Miscellaneous » Optics » Enrolment options

Enrolment options

e, © Substantive Examination training in the field of Optics
« My courses
~ Badge Enrolment

You got all required site badges to enrol into this course!

» Assessment

+» Courses

« Miscellaneous W Users with required badges will
« Optics see the button ‘Enrol me’

= worksharing
b Prior Leaming
» Feedback for a Course
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Substantive Examination training in the field of Optics

Dashboard Courses Miscellaneous » Optics Enrolment options

Enrolment options

Dashboard
e lpa;;s = Substantive Examination training in the field of Optics
» My courses . ooy . .

' You need the following site badge(s) to enrol into this course

» PrevCourses

Training Needs Self- c' ompetency Level 1
»

assessment

4 "H ) Users without required badges

Bl ey will not be able to enroll into the
v Miscellaneous course

= Optics

= worksharing
» Prior Leaming
» Feedback for a Course

Upload Files in User Profile

Sometimes, an examiner is requested to submit curriculum vitae (CV) in order for him/her to
be nominated for a training course. It would also be a good practice for a manager /
coordinator in a patent office to have CV of all examiners in the office.

By default, the user profile input is only in the form of text or date input, or a choice from a
dropdown menu. However, this plugin allows a user to upload files in the user profile. The
plugin can be downloaded here: https://moodle.ora/plugins/profilefield file

Is: File upload Release 2016121900

After downloading the zip file, go to Site administration > Plugins > Install Plugins. Drag the
zip file to the box under the header ‘Install plugin from ZIP file'.
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Dashboard Site administration Plugins nstall plugins Blocks editing on

Plugin installer

Dashboard

= Site home

p Site pages

» My courses Install plugins from the Moodle plugins directory
» PrevCourses
3 1ing Needs

Self-assessment

e - Install plugin from ZIP file

» Optics

P Assessment ZIP package .
Choose a file

profilefield_file_moodle34_2016121900 zip

Drag the ZIP file to this box

w Site administration

£¢ Notifications

¥ Registration

£+ Advanced
features

» Users

p Grades

Competencies Install plugin from the ZIP file Click here to proceed

» Badges

When the installation is successful, click ‘Continue’ to proceed. On the next screen, click
‘Update Moodle database now'.

Install plugin from ZIP file

Validating profilefield_file ... OK

Validation successful, installation can continue
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Plugins requiring attention

Cancel new installations (1)  Plug tion @B
Plugin name / Directory Current version New version Requires Source [ Status
Profile field types

File upload 2016121900 | Additional | To be installed |

Cancel this installation

< Upgrade Moodle database now >

If the installation is successful, this screen will be shown. Click ‘Continue’ to finish
installation.

Upgrading to new version

profilefield_file

Now, go to Site administration > Users > Accounts > User profile fields. ‘File upload’ option is
now available from the dropdown menu for creating a new profile field.

dd anew

Patent Examination details #
£ User default

prefe Profile field
£+ User profile

fields Recruitment as a Patent Examiner
£¥ Cohorts

: Technical Fields
£ Upload

Create a new profile field: | Choose Create a new profile category

Courses
Grades
Competencies

Badges

b_lLocation
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Assuming the file uploaded is related to CV, the short name can be cv, while the name can
be ‘Curriculum Vitae'. Other options include whether to make this field a requirement in the
profile page, maximum number of attachments allowed, visibility to other users, etc. Click
‘Save changes’ to continue.

Creating a new 'File upload’ profile field

T | P—
v Lolapse al

Common settings

Short name (must be unique) *

cv

Name *

Curriculum Vitae

So, when a user goes to the ‘Edit profile’ page, he/she will see the option to upload a file
under the new profile field ‘Curriculum Vitae'. In this example, only 1 attachment is allowed.

Curriculum Vitae

Maximum size for new files: Unlimited, maximum attachments: 1

The uploaded file will be displayed on the profile page under the user details.
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User details

Email address

Sofiarehan . Ramli@wipo.int

Year of Birth
1982

Curriculum Vitae

CV - Sofia Rehan Ramli.docx

Monitoring of Learning Plans

This plugin is useful in providing an overview and statistics of user learning plan without
having to go through the user’s profile page. The download and instructions page can be
found here: https://moodle.org/plugins/report_Ipmonitoring

After a successful installation, the new features can be found by going to Site administration
> Reports > Monitoring of learning plans or Statistics for learning plans.
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» Site administration according 14

I+ Notifications

£+ Registration

£ Advanced

features

Users
ourses This self-as
knowledge
joining a co

Grades
Competencies
Badges
Location
Language
Plugins
Security
Appearance
Front page
Server
» Reports
Comments
Backups
% Config changes
Events list
o Logs

ive logs

£F Monitoring of

learning plans
£F Statistics for
£# Performance
overview
£# Question
instances

Under the item ‘Monitoring of learning plans’, overview of users by learning plan template
can be viewed. Choose the desired template, optionally choose the specific user, then click
‘Apply’ to view the performance.
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Dashboard Site administration Reports Monitoring of learning plans

NAVIGATION

Monitoring of learning plans

Dashboard
* Stehome - Filter
» Site pages
w My courses
PrevCourses Filter by
Training Needs G) Learning plan template
Self-assessment
KPI

Optics Learning p

User

Assessment Supplementary Learning Plan Template ¥

ipc_chemistry Choose a learning plan template

WIPO_DL Supplementary Learning Plan Template

Training for Patent Examiners Level 1
QUSET SEleciEd
EE

ADMINISTRATION

Show more
w Site administration

¥ Notifications

¥ Registration

£ Advanced
features

» Users A Supplementary Learning Plan Template
p Courses

Apply
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A Supplementary Learning Plan Template

Click the arrow to

browse through the :

users having the Admin User
same learning plan

1/4

Status: Active Competencies proficient

3

Competencies not proficient Competencies not rated

List of competencies
and proficiency of

Work-Sharing 8 each of competency

P Expand all

Not rated ©

Produce Examination Reports 10 Not rated @
Supplementary 13 Not rated ©

Nature and function of IP rights 1.1 Proficient v

Each competency can be expanded, and it will show the details that contributed to the
proficiency of the competency (e.g. rating given and course linked to the competency).
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v Nature and function ¢ Clicking the number of ratings
will show the course related to
the competency, and indication

& Total number of rati
9 that the course has been rated

0/0 @ Not yet competent

No data

; available
# Evidence of prior learning B Competent

1 D — Any evidence of prior learning

€, Final rating related to the competency will be
shown here

Competent Proficient

The final rating of the

competency can also be
m < manually given via this page, by V

clicking the ‘Rate’ button

&% IPET Competencies

Another feature of this plugin is a report on statistics for all users under the same learning
plan template. This can be accessed from Site administration > Reports > Statistics for
learning plans.

By choosing the desired learning plan template, statistics on all competencies will be
displayed. Immediately a manager can know how many users are proficient / not yet
proficient for each competency. From the number of total users per competency, it would
also be easy to identify which users that are not yet rated. Clicking the number under ‘Total
users’ would show the list of users having the learning plan.
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Statistics for learning plans

- Filter

Learning plan template Supplementary Learning Plan Template

v

Ratings (® Finalrating

Rating in course

Apply

Work-Sharing s Produce Examination Reports 10

@ Mot yet competent @ Mot yet competent

No data

avalablé B Competent
va =

B Competent

Total users Total users

1/3 0/3

Supplementary 13 Nature and function of IP rights 1.1

BB Mot yet competent B Mot yet competent

No data c
Competent Competent
available . ompoe . ompes

Total users Total users

0/3 13

Although so far there is no overview according to cohorts, a possible workaround would be
creating a learning plan template that will be assigned to all users in the cohort. Since
Moodle permits multiple learning plan templates to be assigned to one user, as long as the
name of the template differs, it does not matter whether the competencies in the template are
the same as other template.
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